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Abstract

Large Language Model (LLM)-based agents are increasingly applied to tasks re-1

quiring structured reasoning, tool use, and environmental adaptation, such as data2

manipulation, multistep planning, and computer-use automation. However, despite3

their versatility, current training paradigms for model weight optimization methods,4

like PPO and GRPO, remain relatively impractical with their high computational5

overhead for rollout convergence. In addition, the resulting agent policies are diffi-6

cult to interpret, adapt, or incrementally improve. To address this, we investigate7

creating and refining structured memory of experiential learning of an agent from8

its environment as an alternative route to agent optimization. We introduce BREW9

(Bootstrapping expeRientially-learned Environmental knoWledge), a framework10

for agent optimization for downstream tasks via KB construction and refinement.11

In our formulation, we introduce an effective method for partitioning agent memory12

for more efficient retrieval and refinement. BREW uses task graders and behavior13

rubrics to learn insights while leveraging state-space search for ensuring robustness14

from the noise and non-specificity in natural language. Empirical results on real15

world, domain-grounded benchmarks – OSWorld and τ2Bench – show BREW16

achieves 10− 20% improvement in task precision, 10− 15% reduction in API/-17

tool calls leading to faster execution time, all while maintaining computational18

efficiency on par with base models. Unlike prior work where memory is treated as19

static context, we establish the KB as a modular and controllable substrate for agent20

optimization – an explicit lever for shaping behavior in a transparent, interpretable,21

and extensible manner.22

1 Introduction23

Large Language Model (LLM) based agents are rapidly being deployed for structured reasoning,24

tool use, and autonomous interaction in real-world environments [16]. From computer-use and25

spreadsheet automation to software engineering pipelines, these agents drive tasks such as multi-step26

planning, data manipulation, and adaptive workflows [21, 13, 32, 2, 19]. For example, a language27

agent might help automate a multi-step workflow like collecting data from different sources, cleaning28

or validating it, and then uploading it onto a dedicated server, all while adjusting its plan if the29

format or structure of the data changes unexpectedly [31, 35, 25, 3]. Yet, despite these successes, top-30

performing agents generally score underwhelmingly on challenging real-world benchmarks—well31

behind human experts, who routinely exceed 70% success rates [34, 4, 27, 18]. As an example,32

consider the following scenario:33
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Figure 1: BREW architecture overview using examples from the OSWorld dataset. Step 1 indicates
the trajectory generation process with agent alignment to human-validated rubrics and correctness
using task-specific grader. Steps 2–4 indicate the Reflector Agent, which learns key concepts and
corresponding insights from trajectories. Step 5 indicates the Integrator Agent, which integrates
knowledge from the Reflector Agent to bootstrap the KB. We introduce Expand-and-Gather MCTS
to further find the best KB configuration as the KB is iteratively refined through reward-guided
optimization.

A computer-use agent in an Ubuntu environment tasked with automating software installa-
tion across multiple sessions. In its first encounter, it struggles through a 47-step process:
opening the wrong package manager, executing redundant dependency checks, and making
23 API calls to complete what could be a 6-step workflow. When presented with a similar
installation task in the next session, the agent repeats the same inefficient exploration – as
if encountering the problem for the first time. A human user, by contrast, would likely have
a recollection from internalized memory of the optimal sequence after the first attempt,
recognizing the environmental patterns and tool combinations that lead to success.

34

This scenario illustrates a fundamental limitation of current language agents: despite their impressive35

capabilities in reasoning and tool use, they lack the ability to accumulate and apply experiential36

knowledge across task sessions. Each interaction begins from a blank slate, forcing agents to37

repeatedly explore the same action spaces and rediscover the same solutions [9]. Real-world tasks38

like long horizon multi-stage automation demand more than just “reactive” [33] tool loops. They39

require persistent & interpretable learnings from past experiences - what works, what fails and why.40

To close this gap, recent work has explored learning agent behavior using model weight optimiza-41

tion [23, 22, 24], where agents are trained to maximize success across a wide variety of tool-use42

episodes. However, while conceptually sound, this suffers from practical limitations. First, it requires43

expansive exploration over large rollout spaces to converge, especially in domains where tasks are44

diverse, goals are sparsely defined, and intermediate feedback is noisy or delayed. Second, the45

resulting policies are often opaque—difficult to interpret, revise, or debug—limiting their real-world46

deployability. Finally, these policies are tightly coupled to the task distributions they were trained on,47

making it difficult to adapt or incrementally improve them when downstream requirements shift.48

In contrast, others have explored learning of knowledge onto a memory module that remains attached49

to an agent. These existing memory-augmented agents can be broadly classified into either ones which50

(i) store only transient trajectory contexts that vanish between episodes like Mem0 [7, 29], or (ii)51
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embed high-level notes directly in the prompt such as MetaReflection [10] and GEPA[1]. While the52

latter often do not retain actionable details for future simple tasks, neither of these approach supports53

modular updates, fine-grained retrieval, or transparent inspection of what the agent “knows.” [28].54

Leveraging learnings from both camps, we introduce BREW (Bootstrapping experientially-learned55

environmental knowledge), a framework that incrementally constructs and refines a knowledge base56

(KB) a structured collection of concept-level documents in natural language, directly from an agent’s57

past interactions. This KB then serves as a persistent memory for the agent to retrieve knowledge in58

future executions to improve precision and efficiency outcomes. Our key contributions are–59

• Novel experience-driven KB construction. We propose a technique for leveraging agent’s past60

interaction trajectories to generate uniquely-partitioned concept-level KB documents. This process61

is guided by rubrics and task-specific graders which ensures that memories are both semantically62

aligned with task objectives and human-interpretable.63

• State-space search for memory optimization. We formalize the selection and update of KB entries64

as a state search problem and introduce an efficient reward-guided learning scheme, Expand-and-65

Gather Monte Carlo Tree Search (EG-MCTS), that learns to prioritize the most impactful memories66

for robust, multi-step reasoning.67

• State-of-the-art results. On domain-grounded benchmarks including OSWorld and τ2Bench,68

BREW achieves significant gains of in the range of 10− 20% towards task precision as well as69

10− 15% fewer steps leading to faster execution, while maintaining memory and compute costs70

comparable to base LLMs.71

2 Preliminary & Related Work72

Agent Learning from Demonstrations Recent work has leveraged LLMs to isolate reusable73

skills through interactive decomposition: one method distills sub-goals from expert trajectories into74

hierarchical planning and execution policies [11], and another synthesizes executable functional75

abstractions for advanced mathematical reasoning via program induction [14]. These approaches76

focus on structured skill extraction from LLM-guided interactions, yet remain reliant on static77

decomposition or offline synthesis. In contrast, BREW dynamically constructs and refines an78

experiential memory—learning necessary semantic fragments via rollout-generated insights and79

structured knowledge-base search (MCTS)—to support long-horizon, memory-augmented planning.80

Agentic Memory The concept of providing agents with controllable memory has a rich history.81

[17]. Memory mechanisms are attracting more and more attention lately [20, 26, 28, 7, 30, 12]. These82

works focus towards storing relevant context in a structured format like graph or a tree so as to RAG83

over it. Despite their effectiveness these methods perform well for most cases. However, when the84

queries are ambiguous, requires multi-hop reasoning and long range comprehension these techniques85

struggle to perform the tasks [12]. In contrast to prior works BREW uses a state search to explore86

possible memory states. This allows BREW to select the memory state where the reward during87

exploration is highest making it more robust to ambiguous queries and long range comprehension.88

We employ MCTS [8] as a state search algorithm to explore the potential states of the memory by89

expanding to new and potentially different states of memory based on same interactions. We discuss90

the state search process more formally in Section 3.3.91

3 BREW: Architecture92

This section describes our proposed Bootstrapping expeRientially-learned Environmental knoWledge93

model, BREW, which constructs and iteratively refines a KB using trajectory insights guided94

by human-validated general-purpose agent behavior metrics, task-specific evaluation, and latent95

insight generation. We introduce a novel decomposition the problem of learning the optimal KB by96

partitioning memory as local documents associated with semantic concepts, and formulate the KB97

learning problem as a state space search by proposing Expand-and-Gather Monte Carlo Tree Search98

(EG-MCTS). Figure 1 provides an architecture overview of BREW, and Algorithm 1 describes99

pseudocode.100
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3.1 Trajectory Generation101

Given the training dataset, we generate full-length trajectories, hereby referred to as rollouts, for102

each query using an LLM-powered agent conditioned on its associated KB. At initialization, the KB103

is empty, and the LLM is used with a decoding temperature of 0 to ensure deterministic behavior.104

Further details on training and test splits are in Experiments Section. Each rollout is evaluated using a105

correctness grader, which assigns a binary label: success or failure and a qualitative rubric assessment106

against a set of human-validated general-purpose agent behavior rubrics [6] (Step 1 in Figure 1).107

3.2 Reflector and Integrator Agents108

Reflector Agent: ReflAgent takes as input a rollout with its rubric and correctness labels, and109

outputs sentence-level insights with mapped concepts:110

{concepts, insights} = ReflAgent({rollout, eval}). (1)

Examples of concept–insight pairs appear in Step 2 of Figure 1.111

Concept Deduplication: Concept–insight pairs are annotated independently per rollout, often112

producing overlapping or paraphrased concepts. We address this via semantic clustering (Steps 3–4,113

Figure 1; Algorithm 1, line 3): contextual embeddings for each concept are generated using an LLM,114

clustered, and each insight is mapped to its cluster representative. Details appear in Algorithms 2 and115

3 in Appendix A.116

Integrator Agent: IntegAgent incrementally builds and refines KB documents {d(si)} ∈ D(si)117

during environment interaction. Instead of a centralized memory, the KB is partitioned into local118

documents, each tied to a meta concept. This design enables (1) efficient, context-specific retrieval;119

(2) modular updates with minimal interference; and (3) natural alignment with task semantics, as120

deduplicated meta concepts capture meaningful behavioral abstractions. Unlike prior work assuming121

flat memory or dialogue histories, this structure is well-suited for long-horizon, procedural tasks122

where behaviors cluster around discrete skills.123

The KB is dynamically populated: concepts central to the dataset receive more updates, shaping124

memory around frequent behaviors. At each state, for meta concept k, IntegAgent updates its125

document dk via126

dk(si+1)← IntegAgent(k, insightsk, dk(si)). (2)
To reduce LLM variance and improve consistency, we use the Expand-and-Gather MCTS (EG-MCTS)127

method (Figure 2).128

Formally, the KB at state si is the union of all concept-localized documents:129

D(si) =
⋃
k∈K

{dk(si)}, (3)

where K is the set of all meta concepts and dk(si) is the document for concept k at state si.130

3.3 Expand-and-Gather MCTS for Optimal KB Search131

We start by creating a set of meta-concepts after deduplicating concepts extracted by ReflAgent132

using the first set of trajectory rollouts. We freeze this meta-concept set K, and use it to initialize a133

KB with an empty document per concept k ∈ K.134

We model the problem of finding the optimal KB D∗ as a search problem in the state space of all135

possible KBs D. To simplify this state search, we model KB D as a collection of concept level136

documents. This modeling allows us to break down the larger search space into a collection of137

simpler document level search problems for each concept k to find the optimal document d∗k. We then138

construct the optimal KB D∗ by combining all optimal documents d∗k for each concept k as follows:139

D∗ =
⋃
∀k

{d∗k} (4)

Notably, even though we are modeling document level search as independent optimization problems,140

each document in the KB is not independent of the others. For example, an agent can retrieve any141
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Algorithm 1 BREW: Bootstrapping Experientially-learned Environmental Knowledge
Require: Training samplesQtrain, eval samplesQeval, rubrics, iterations M , candidates per expansion

h
Ensure: Optimized KB D∗

Initialization
1: D0 ← ∅
2: B ← GENERATEINSIGHTS(Qtrain,D0, rubrics)
3: K ← DEDUPLICATECONCEPTS(B) ▷ Initial concept set
4: for each k ∈ K do
5: d0k ← INTEGAGENT(k, Ik,∅)
6: Initialize treek with root node d0k
7: end for
8: Dcurrent ←

⋃
k∈K{d0k} ▷ Initial KB

EG-MCTS Optimization
9: for t = 1 to M do ▷ Parallel expansion across concepts

10: for each k ∈ K do
11: sk ← SELECTBESTNODE(treek) ▷ UCT selection
12: Dbest ←

⋃
k′∈K{dbest

k′ } ▷ Current best docs
13: EXPANDNODE(sk, k, h, Dcurrent, Dbest, treek)
14: end for ▷ Update current best documents
15: for each k ∈ K do
16: dbest

k ← best document in treek
17: end for
18: Dcurrent ←

⋃
k∈K{dbest

k }
19: end for
20: return Dcurrent

Time Complexity: O(|Qtrain| · TLLM +M · |K| · h · Tagent)

document in the KB during inference and this retrieval making it hard to assess the impact of changing142

a document in isolation. To solve this we propose Expand-and-Gather MCTS (EG-MCTS), which143

enables searching these disjoint state spaces concurrently using parallel MCTS explorations that are144

synced after each iteration. To achieve this we perform node expansions in the respective search145

spaces independently but condition reward calculation and insight generation on a running optimum146

KB state. Each iteration of EG-MCTS can be broken down two phases:147

Expand Phase: During this stage, for each search tree, we pick the best state s∗ and expand148

it concurrently. To perform this expansion the KB D(s∗) is constructed by including the current149

document dk(s∗) and the best (oracle) documents {d∗i }i ̸=t for all other positions. Thus, the KB at150

iteration t, 0 ≤ t ≤ E is defined as:151

Dt = dt ∪ d∗i:i ̸=t (5)
We use this KB D(si) to generate trajectory rollouts which are consumed by the ReflAgent to152

generate insights. We then use the IntegAgent to generate various updated variants of d∗k e.g.,153

dk(si), ..., dk(sj), where 0 ≤ i ≤ E and 0 ≤ j ≤ E. We then estimate a reward R for each of these154

newly generate states and update rewards of parent states using backpropagation.155

Gather Phase: During this stage, the current best states from each document’s MCTS tree are156

gathered together and distributed to every MCTS tree for reward calculation. This is important to157

1. Estimate rewards for each expanded state, and 2. Generate new insights for further node expansion.158

3.4 Reward-Guided Optimization159

This section describes BREW’s joint reward and loss optimization for learning an optimal KB.160

Reward Objective: Each document state is rewarded based on two complementary criteria: (i) how161

well the current document contributes to accurate downstream reasoning, and (ii) how retrievable162

it is in the context of a growing KB. Formally, the total reward at time step t is defined as:163

Rt = λcorr ·Rcorr
t + λret ·Rret

t (6)
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𝐭𝐫𝐞𝐞𝐤

## Search and Open Files  
**Purpose:** Locate and open files 
(documents, images, downloads) for 
further work.

**How-To:**  
- Launch File Manager (Nautilus) via 
launcher, dock, or `Super + E`.  
- Search: Press `Ctrl + F` or use the 
search icon.  
- Enter part or all of the filename 
(wildcards like `*.pdf` work).  
…

## Search and Open Files

**When to use**: To find documents, 
spreadsheets, images, or downloads for 
editing, conversion, or attachment.

### How to Perform
- Open File Manager (Nautilus) via 
launcher or dock  
- Press `Ctrl + F` or click the search 
icon  
- Enter part of the filename, full name, 
or use wildcards (`*.pdf`, ̀ report*`)  
…

𝒅𝒌(𝒔𝒊)

…

## Search and Open Files

**When to use**: To find documents, 
spreadsheets, images, or downloads for 
editing, conversion, or attachment.

### How to Perform
- Open File Manager (Nautilus) via 
launcher or dock  
- Press `Ctrl + F` or click the search 
icon  
- Enter part of the filename, full name, 
or use wildcards (`*.pdf`, ̀ report*`)  
…

𝒅𝒌(𝒔𝒊)

Node expansion at state 𝑠𝑖  for meta-concept 𝑘, 1 ≤ 𝑘 ≤ 𝐾.  

Node
Expansion

𝒅𝒌(𝒔𝒋)

𝒅𝒌(𝒔𝒊+𝟏)

𝐭𝐫𝐞𝐞𝐤

## Search and Open Files

**Quick Reference Table:**

+----------------------+-------------------------------+---------------------------+
| Task  | Shortcut/Action  | Tip  |
+----------------------+-------------------------------+---------------------------+
| Open File Manager  | Launcher, Dock, Super + E  | Pin to dock for speed  |
| Search Files  | Ctrl + F or Search icon  | Use * as wildcard  |
| Open File  | Double-click or Right-click  | "Open With" for choice  |
| Fast Folder Access  | Use sidebar in File Manager  | Add favorites  |
+----------------------+-------------------------------+---------------------------+

𝐸 iterations of MCTS, such that 0 ≤ 𝑖 ≤ 𝐸, 0 ≤ 𝑗 ≤ 𝐸. State 𝑠𝑖 = 𝑐ℎ𝑖𝑙𝑑_𝑜𝑓(𝑠𝑝) and 
𝑠𝑗 = 𝑐ℎ𝑖𝑙𝑑_𝑜𝑓 𝑠𝑝  for meta-concept 𝑘, 1 ≤ 𝑘 ≤ 𝐾.

 

Expand Phase

Gather Phase

Iterations E

Reward Estimation: 
𝑅𝑐𝑜𝑟𝑟 + 𝑅𝑟𝑒𝑡

Expand Phase

…

Current best nodes from each 
MCTS tree are expanded by 

each MCTS node

Figure 2: Illustration of BREW’s KB optimization process using Expand-and-Gather MCTS with
OSWorld examples. In the Expand Phase, for each document k, we sample the best node from
treek using UCT and perfrom node expansion. Node rewards are estimated based on correctness
and retrievability. In the Gather Phase, the current best nodes from each tree are gathered per node,
and the objective function is optimized. The process is repeated during the next iteration of KB
refinement.

where Rcorr
t is the correctness reward, Rret

t is the retrieval reward, and λcorr, λret ∈ [0, 1] are scalar164

weights with λcorr + λret = 1.165

Correctness Reward: The correctness reward Rcorr
t evaluates the accuracy of the agent’s output166

over a held-out query set Q, when reasoning over the current KB Dt. It is defined as:167

Rcorr(dt|Dt) =
1

|Q|
∑
q∈Q

Evaltask(q, agent⊕Dt) (7)

where Evaltask is a task-specific evaluation function (e.g., question-answering accuracy, entailment168

correctness), and agent⊕Dt denotes the agent acting over the hybrid KB.169

Retrieval Reward: The retrieval reward Rret
t measures how effectively the current document dt170

can be retrieved from the current KB Dt. For a held-out query set Q, it is computed using the mean171

reciprocal rank (MRR):172

Rret(dt|Dt) =
1

|Q|
∑
q∈Q

MRRq(dt,Dt) (8)

This encourages documents that are not only helpful in reasoning but also easily retrievable via the173

retrieval model over Dt.174

4 Experimental Setup175

Datasets We evaluate BREW on three diverse benchmarks testing different aspects of interactive176

agent capabilities: OSWORLD for computer-use automation [27], τ2-Bench for tool use [5], and177

SPREADSHEETBENCH for data manipulation [18].178

1. OSWorld: This benchmark tests multimodal agents on real-world computer tasks across 10179

applications. We use GTA1-7B, a state-of-the-art computer-use agents with BREW. Tasks are180

evaluated using 134 custom scripts that verify final application states.181

2. τ2-Bench: This benchmark evaluates conversational agents on multi-turn tool-use scenarios across182

Telecom, Retail, and Airline domains. We test o4-mini-based tool-calling agent, constructing183

BREW KBs for every domain.184
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3. SpreadsheetBench: This benchmark evaluates agents on real-world spreadsheet manipulation,185

spanning both cell-level and sheet-level tasks. It contains 912 authentic user instructions paired186

with 2,729 test cases (3̃ per instruction), sourced from Excel forums and blogs. Spreadsheets187

include diverse formats with multi-table sheets (35.7%) and non-standard tables (42.7%). We test188

o4-mini using a Python tool-calling agent, and enhance it with by adding an embedding based189

Retrieval over the BREW KB generated over a small held-out train set of 30 samples.190

Baselines We compare BREW against two widely used experiential memory approaches, Cognee1191

and Agent-Mem [30], both of which serve as established baselines for AI memory evaluation. Cognee192

is an open-source AI memory engine that employs a graph-plus-vector memory architecture through193

an Extract–Connect–Learn pipeline, enabling agents to construct cross-document and cross-context194

connections entirely from previously available trajectories. In contrast, Agent-Mem provides a195

scalable memory layer for dynamically extracting and retrieving information from conversational data,196

with enhanced variants incorporating graph-based memory representations. While Cognee primarily197

emphasizes cross-document relational reasoning, Agent-Mem focuses on scalable personalization for198

conversational agents.199

Other Experimental Configs: For all experiments, we use GPT-4.1-2025-04-14 as the base200

LLM with expansion width e = 3, max depth k = 3, and balanced reward weights λcorr = λret = 0.5.201

During MCTS node selection, we use the UCT [15] for balancing exploration and exploitation Full202

experimental details are provided in the Appendix.203

5 Analysis & Discussion204

In this section, we present findings from our evaluation of BREW. For more details on qualitative205

insights and discussion you may refer to the supplementary material.206

Variations with State Search Strategy BREW performs a search across possible KB states using207

MCTS. We compare different state search strategies to determine the relative trade-offs:208

1. Iterative Refinement: In this strategy we generate one version of each document to generate an209

initial KB, followed by a round of evals. We then use the aggregator agent to refine the documents210

over the newly learned insights. We repeat this step multiple times up to a maximum number of211

refinements. Note that in contrast to MCTS, in this strategy we do not perform node expansions212

and rather explore a path in the search tree.213

2. Greedy Search: In this strategy we greedily pick the best state during each node expansion and214

only explore the sub-tree within it. This is in contrast to MCTS where, we explore different states215

using the UCT algorithm that balances exploration and exploitation.216

Table 1 presents how MCTS achieves consistent performance gains across all benchmarks. These217

represent 1-5% improvements over alternative search strategies across tasks. Iterative refinement’s218

poor performance reveals core limitations in the integrator agent feedback incorporation- which can219

be attributed to inherent stochasticity in LLMs. This makes state exploration especially important for220

textual optimization tasks like ours. We present a detailed analysis on how varying MCTS parameters221

result in different final states in appendix.222

5.1 Trends across Sub-Tasks223

BREW learns recipes from sub-trajectories in OSWorld. Figure 3 shows that BREW(BREW)224

improves success rates in 5 out of 10 OSWorld categories, achieving absolute gains of 4–16%225

while maintaining performance parity in the remaining categories (Chrome, Gimp, LibreOffice226

Calc, LibreOffice Impress, OS). The largest improvements appear in text-processing applications227

(LibreOffice Writer: 14% → 24%, Thunderbird: 38% → 54%) and multimedia tools (VLC:228

20% → 27%), with moderate gains in multi-application and development environments. Even in229

settings with limited improvements in task correctness, BREWconsistently reduces execution length230

by 14–23 steps, highlighting more efficient planning.231

1github.com/topoteretes/cognee
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Method OSWorld τ2 Bench SpreadsheetBench
GTA1-7B o4-mini o4-mini

Baseline 44.20 56.63 44.30
Cognee 46.70 57.71 42.10
Agent-Mem 43.83 52.69 42.00
BREW-Iterative 46.13 57.34 42.98
BREW-Greedy 45.55 59.14 45.94
BREW-MCTS 47.56 59.14 46.80

Table 1: Comparison of models under different evaluation setups, including Baseline model and
BREW augmented model. We report task success rate for OSWorld, ratio of independent tasks that
succeeded for τ2 Bench, and the 1st test case pass rate for SpreadsheetBench.
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OSWorld: Success Rate Comparison and Efficiency Gains
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Figure 3: The bar plot represents the category-wise success rate over various tasks in the OSWorld
dataset over the GTA1-agent, whereas the line plot demonstrates the reduction in the number of steps
for the successful cases. Note that even in scenarios where the KB doesn’t help increase the success
rate, it significantly reduces the number of steps needed to succeed.

This pattern suggests that BREW’s architectural enhancements are particularly effective for tasks232

requiring complex sequential reasoning and inter-application coordination, while preserving baseline233

robustness in domains constrained by intrinsic task complexity.234

A qualitative analysis of the knowledge bases (KBs) constructed by BREWfurther supports this235

finding. We observe that BREWcaptures and represents sub-trajectory characteristics in natural236

language, including application shortcuts, standard operating procedures, and strategies for localizing237

UI elements. Since many UI tasks share common sub-trajectories, this representation facilitates238

knowledge transfer across tasks within the same application. Moreover, BREWsubstantially reduces239

reliance on granular UI interactions: while the baseline GTA1 model executes approximately 19,000240

clicks and 17,821 keyboard actions, BREWsignificantly decreases this interaction complexity.241

BREW learns aggressive resolution strategies for τ2−Bench To evaluate robustness of BREW,242

we analyzed the distribution of failure modes across the τ2–retail dataset, focusing on four key error243

categories: Wrong Argument, Wrong Info, Wrong Decision, and Partially Resolve. Figure 4 presents244

a comparative chart for the baseline, BREW, Cognee and Agent-Mem[30].245
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Overall, BREW demonstrated consistent improvements across most error types compared to the246

baseline and competing approaches. Specifically, BREW showed a notable reduction in “Wrong247

Argument” and “Wrong Decision” errors, indicating that it was better at capturing logical depen-248

dencies in retail dialogues and making accurate decisions.249

Interestingly, Partially Resolve errors were slightly higher for BREW than for Cognee, likely because250

BREW attempted more aggressive resolution strategies that occasionally failed to fully satisfy user251

queries. Cognee appears to capture richer factual details given its relatively lower Wrong Info errors,252

whereas Agent-Mem excels in tracking conversation state and decision accuracy, as reflected in its253

reduced Wrong Decision failures.254

Improvements in Task Efficiency We observe that overall, BREWenables agents to come to a255

correct response quicker.256

OSworld. Figure 3 demonstrates that BREW enables GTA1 to complete tasks more efficiently.257

Compared to the baseline GTA1 model’s average of ∼75 steps, the BREW-augmented model258

completes tasks 14% faster with an average of∼64 steps. Analyzing performance by outcome reveals259

that while step counts remain unchanged for failed cases, successful completions show a substantial260

39% (rel.) reduction in execution steps, indicating improved planning efficiency for achievable tasks.261

Wrong argument

Wrong info

Wrong decision

Partially resolve

Baseline
BREW

Cognee
AgentMem

Figure 4: Distribution of errors in τ2 Bench Retail

τ2Bench. Similarly, BREW reduces average262

conversation turns from 29.47 to 28.43 (-3.5%),263

while maintaining consistent step reductions264

across categories. Step reductions average 1.7265

steps for Retail and Telecom, but 3.1 steps for266

Airline, indicating greater efficiency gains in267

complex domains. Qualitative analysis sec-268

onds these numbers showing how knowledge269

base integration enables more direct task com-270

pletion paths and improved planning quality,271

though multi-turn interactions remain necessary272

for complex sub-tasks.273

SpreadsheetBench. While we observe a slight274

increase in the number of turns across the entire275

benchmark suite (4.5→ 5.4) in the case of the276

baseline versus BREW, an interesting pattern277

emerges in more than 82% of the cases the base-278

line and the BREW appended agent performs279

similarly with similar turn consumption. BREW leads to an improvement in 12% of the cases where280

the KB is able to address gaps in the baseline technique to enable the agent to go exploring further281

leading to positive outcomes with an average of 1 step increase in the interactions.282

6 Conclusions283

In this work, we explored an alternative approach to agent optimization by focusing on experiential284

knowledge retention rather than direct model fine-tuning. We introduced BREW, a framework that285

aims to construct and refine a structured, interpretable knowledge base from past agent interactions.286

By decomposing agent memory into concept-level documents and applying a state-search optimiza-287

tion strategy, BREW provides a modular and transparent substrate for memory formation. Our288

evaluations across OSWorld and τ2Bench benchmarks suggest that such structured memory can289

support measurable improvements in task success and efficiency, while maintaining manageable290

computational costs. Although the observed gains are promising, we recognize that BREW’s effec-291

tiveness is influenced by the quality and coverage of its training data. Future work could explore292

more adaptive and domain-general memory refinement techniques, as well as tighter integrations with293

ongoing agent planning. Ultimately, we hope this study encourages further investigation into more294

interpretable, memory-driven approaches to language agent development—especially in real-world295

environments where long-term consistency and adaptability are essential.296
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A Appendix421

A.1 Details of the BREWAlgorithm422

We provide pseudocode for the core components of BREW, aligning with the stages introduced in423

Section 3. Each algorithm plays a distinct role in constructing, organizing, or refining the knowledge424

base over iterative interactions. GENERATEINSIGHTS (Alg. 2) produces concept-aligned insights425

from annotated rollouts using ReflAgent. DEDUPLICATECONCEPTS (Alg. 3) clusters semantically426

overlapping concepts into a compact meta-concept set. INTEGAGENT incrementally builds and427

updates per-concept documents using newly generated insights. Finally, EXPANDNODE (Alg. 4)428

performs MCTS-guided expansions to explore improved document variants, while EVALUATE (Alg. 5)429

scores candidate KB states using correctness and retrieval-based rewards.430

We specify the IntegAgent prompt below:431

BREW Integrator Prompt432

433
# Enhanced Documentation Editor Prompt434

435

You are a meticulous documentation-level editor specializing in comprehensive436

technical reference materials. You will be given a list of topic nodes,437

each containing structured information that must be preserved and enhanced438

with maximum detail retention.439

440

## Input Structure Analysis441

Each node contains:442

- **Title**: The primary topic identifier443

- **Context**: Background information and conceptual foundation444

- **How to Use**: Step-by-step instructions, commands, flags, parameters, and445

implementation details446

- **When to Use**: Specific scenarios, conditions, and decision criteria447

- **Best Practices**: Expert recommendations, optimization techniques, and448

common pitfalls to avoid449

450

## Detailed Processing Requirements451

452

### 1. Information Preservation (Zero Loss Policy)453

- **Preserve every technical detail**: All command-line flags, parameter values,454

configuration options, file paths, URLs, version numbers, and exact syntax455

- **Maintain all examples**: Keep every code snippet, sample input/output, file456

names, directory structures, and command sequences exactly as provided457

- **Retain contextual nuances**: Preserve qualifying language like "typically,"458

"usually," "in most cases," "when available," and conditional statements459

- **Keep quantitative data**: Preserve all numbers, measurements, timeframes,460

limits, thresholds, and statistical information461

- **Maintain cross-references**: Keep all mentions of related tools,462

dependencies, prerequisites, and interconnected concepts463

464

### 2. Enhanced Detail Extraction465

- **Expand abbreviations**: When encountering shortened forms, expand them466

naturally while preserving the original467

- **Surface implicit knowledge**: Make obvious assumptions explicit (e.g., "this468

requires root permissions," "assumes default configuration")469

- **Clarify relationships**: Explicitly describe how different components,470

options, or steps relate to each other471

- **Highlight edge cases**: Emphasize special conditions, exceptions, or unusual472

scenarios mentioned in the source473

- **Elaborate on consequences**: When the source mentions outcomes, expand on474

both success and failure scenarios475

476

### 3. Prose Transformation Guidelines477

- **Bullet integration**: Transform each bullet point into 1-3 complete478

sentences that naturally flow together479
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- **Technical precision**: Use precise technical vocabulary while maintaining480

readability481

- **Logical flow**: Organize information within each section to follow a logical482

sequence (setup →execution →verification)483

- **Contextual embedding**: Weave code snippets and technical terms seamlessly484

into narrative sentences485

- **Comprehensive coverage**: Ensure every sub-bullet, nested item, and486

parenthetical note becomes part of the prose487

488

### 4. Structural Requirements489

- **Heading hierarchy**: Use ‘# Title‘ for each node’s main heading490

- **Section order**: Maintain Context →How to Use →When to Use →Best491

Practices sequence492

- **Paragraph organization**: Create substantial paragraphs (3-6 sentences)493

rather than brief statements494

- **Transition quality**: Craft smooth bridges between sections and between495

different nodes496

- **Code formatting**: Preserve all inline code with backticks and maintain497

proper formatting for code blocks498

499

### 5. Quality Assurance Checklist500

Before finalizing, verify:501

- [ ] Every piece of source information appears in the output502

- [ ] All technical specifications, parameters, and examples are intact503

- [ ] Code snippets maintain their exact syntax and formatting504

- [ ] Prose flows naturally without choppy or fragmented sentences505

- [ ] Each section provides comprehensive coverage of its topic area506

- [ ] Cross-references and dependencies are clearly explained507

- [ ] No section labels or formatting artifacts remain in the prose508

509

## Output Specifications510

Generate a single, cohesive markdown document that reads as authoritative511

technical documentation. The result should be comprehensive enough that a512

reader could successfully implement the described tools or techniques using513

only the information provided, without referring back to the original514

nodes.515

516

---517

518

**Input Nodes:**519

<NODES>520

{node_list}521

</NODES>522

523

---524

525

Now, produce the aggregated markdown reference sheet with maximum detail526

preservation and enhanced clarity.527528

Algorithm 2 GenerateInsights: Extract behavioral insights from trajectories
Require: Queries Q, KB D, rubrics
Ensure: Concept-insight pairs B

1: B ← ∅
2: for each query q ∈ Q do
3: τ ← LLM(q,D) ▷ Generate trajectory
4: label← GRADE(τ ) ▷ Success/failure
5: (c, i)← REFLAGENT(τ, rubrics, label)
6: B ← B ∪ {(c, i, q)} ▷ Store with source query
7: end for
8: return B
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Algorithm 3 DeduplicateConcepts: Cluster similar concepts and map queries
Require: Concept-insight-query triples B
Ensure: Meta-concepts K with mapped queries and insights

1: Extract all concepts from B
2: Embed and cluster concepts by similarity
3: K ← cluster representatives
4: for each k ∈ K do
5: Qtrain

k ← {training queries that contributed insights to k}
6: Qeval

k ← {held-out queries relevant to k}
7: Ik ← {all insights mapped to concept k}
8: end for
9: return K with associated queries and insights

Algorithm 4 ExpandNode: Generate and evaluate new document variants
Require: Node s, concept k, candidates h, current KB Dcurrent, best docs Dbest, tree
Ensure: Updated tree with new evaluated nodes

1: ▷ Generate new insights from concept-relevant queries
2: Bnew ← ∅
3: for query q ∈ Qtrain

k do
4: τ ← LLM(q,Dcurrent)
5: (c, i)← ANNOTATE(τ, rubrics, ·)
6: if c maps to k then
7: Bnew ← Bnew ∪ {i}
8: end if
9: end for

10: ▷ Generate and evaluate candidate documents
11: for j = 1 to h do
12: dk,j ← INTEGAGENT(k, Ik ∪ Bnew, d

s
k)

13: ▷ Evaluate using hybrid KB with best docs from other concepts
14: Dhybrid ← {dk,j} ∪ {dk′ ∈ Dbest : k

′ ̸= k}
15: Rk,j ← EVALUATE(dk,j ,Dhybrid,Qeval

k )
16: ▷ Add to tree and backpropagate
17: Add (dk,j , Rk,j) as child of s in tree
18: Backpropagate Rk,j from new node to root
19: end for

Algorithm 5 Evaluate: Score document using held-out queries
Require: Document dk, hybrid KB Dhybrid, eval queries Qeval

k
Ensure: Reward score R

1: Rcorr ← 0
2: Rret ← 0
3: for each q ∈ Qeval

k do
4: Rcorr ← Rcorr+ EVAL(q, agent⊕Dhybrid)
5: Rret ← Rret+ MRR(dk, q,Dhybrid)
6: end for
7: Rcorr ← Rcorr

|Qeval
k |

8: Rret ← Rret

|Qeval
k |

9: return λcorr ·Rcorr + λret ·Rret

A.2 BREW Configurations529

Base LLM Configuration For all BREWalgorithm steps, we use the OpenAI GPT-4.1-2025-04-14530

model as the underlying language model. To balance exploration and stability, we set the temperature531

15



to 0.7 for the IntegAgent component to encourage diversity in sampled completions, while all other532

calls use a temperature of 0.1 for deterministic behavior. The search process employs an expansion533

width of e = 3, a maximum search depth of k = 3, and a maximum of n = 10 iterations. Reward534

signals are weighted equally across correctness and retrieval relevance, with λcorr = λret = 0.5.535

A.3 Baseline Methods536

We compare BREWagainst two common reasoning baselines. Step-Back Prompting encourages537

backward reasoning by guiding the model to work from the final task objective back to the initial538

actions. In-Context Learning augments the input prompt with successful trajectories from related539

tasks, enabling the model to benefit from relevant prior examples without additional fine-tuning.540

A.4 Benchmark Specifications541

A.4.1 OSWorld: Computer-Use Automation542

Dataset Overview OSWorld [27] comprises 369 real-world computer-use tasks spanning 10 distinct543

applications. The benchmark is divided into train and test sets, with the distribution of tasks across544

domains shown in Table 2.545

Agent Specifications The UI-Tars-7B variant is a 7B-parameter multimodal transformer fine-tuned546

for graphical user interface understanding. It operates over an action space of PyAutoGUI commands547

(e.g., click, type, and key presses). The agent integrates a retrieval module that queries a task-relevant548

knowledge base using the user-provided description, with the top three retrieved items added to the549

system prompt. Inputs to the model consist of a screenshot of the active UI paired with the natural550

language task description.551

The GTA1-7B configuration adopts a two-agent architecture, consisting of a planner and a grounding552

module. The planner (GTA-1-7B) generates the high-level action sequence, while the grounding553

module (OpenAI O3) verifies and refines each action before execution. Knowledge retrieval is554

incorporated differently for each component: the planner performs a single retrieval at the start555

of execution, which is persisted in its prompt, whereas the grounding module performs dynamic556

retrievals at each verification step.557

Evaluation Protocol Evaluation uses 134 task-specific scripts designed for automated verification.558

Success criteria include file state checks (e.g., validating .xlsx or .docx outputs), UI element559

validation to confirm correct interaction, and process completion checks to ensure that the intended560

automation sequence was executed successfully.561

A.4.2 τ2-Bench: Interactive Tool Usage562

Dataset Overview τ2-Bench [5] extends τ -Bench by introducing bidirectional tool-calling capa-563

bilities. The dataset covers multiple service-oriented domains, with domain-level task distributions564

summarized in Table 3.565

Domain Characteristics The benchmark spans several domains with distinct task characteristics.566

The Telecom domain focuses on connectivity troubleshooting, plan modifications, and service567

activation workflows. The Retail domain includes order processing, return handling, and inventory568

queries. The Airline domain emphasizes booking modifications and policy-compliant rescheduling569

scenarios.570

Interaction Settings Two interaction modes are defined. In Easy mode, a human proxy (imple-571

mented via GPT-4.1) provides detailed guidance to the agent. The knowledge base is built exclusively572

from Easy mode trajectories, ensuring high-quality demonstrations for learning. In Hard mode,573

human intervention is minimized. The knowledge base combines both Easy and Hard trajectories,574

testing the agent’s robustness to underspecified or noisy instructions.575

Evaluation Criteria Task success is measured using domain-specific verification procedures. These576

include database state checks to validate final outcomes, status checks for confirming service or577

connection state, natural language verification to ensure correct confirmation statements appear in578

dialogue, and action matching to confirm that all required steps are completed. Each domain uses a579

tailored subset of these checks (e.g., Telecom relies primarily on status checks).580
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Domain Test Train
Calc 45 2
Chrome 44 2
Writer 21 2
Gimp 24 2
Impress 45 2
Os 22 2
Thunderbird 13 2
Multi-apps 99 2
VLC 15 2
VSCode 21 2

Total 349 20
Table 2: Test and Train samples across different domains in OSWorld.

Domain Test Train
Telecom 105 7
Retail 105 7
Airline 44 6

Total 254 20
Table 3: Task-wise breakdown for τ2-Bench with assumed 2-shot training samples per domain.

Domain Characteristics581

• Telecom: Connectivity issues, plan management, service activation582

• Retail: Order processing, returns, inventory queries583

• Airline: Booking modifications, policy-compliant rescheduling584

Evaluation Criteria Task success determined by:585

• Database Checks: Final state verification586

• Status Checks: Service/connection state validation587

• NL Checks: Confirmation statements in dialogue588

• Action Matching: Required action sequence completion589

Note: Each domain uses specific check combinations (e.g., Telecom uses only status checks).590

A.4.3 SpreadsheetBench: Real-World Spreadsheet Manipulation591

Dataset Overview SpreadsheetBench [18] consists of 912 instructions collected from four major592

Excel forums and blogs. Each instruction is paired with spreadsheets reflecting authentic, complex593

user scenarios, often containing multiple tables and non-standard relational structures. The dataset594

totals 2,729 test cases, averaging three per instruction. A breakdown of cell-level and sheet-level595

manipulations is shown in Table 4.596

Task Settings The benchmark defines two dimensions of evaluation:597

• Granularity: Instructions involve either cell-level manipulations (specific ranges such as598

D2:D6) or sheet-level manipulations (entire tables or multi-sheet updates).599

• Evaluation: Performance is measured using an Online Judge (OJ)-style protocol. The soft600

setting (IOI-style) awards partial credit when only some test cases are solved, while the hard601

setting (ICPC-style) requires solutions to succeed on all test cases.602

Agent Configuration We evaluate603

texttto4-mini using a function-calling agent connected to a single Python execution tool. The604
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agent translates natural language instructions into Python code for spreadsheet manipulation (e.g.,605

modifying cells, applying formulas, restructuring tables). After each tool call, all formulas in the606

spreadsheet are recalculated to ensure consistency before proceeding to the next step. This setup607

provides a controlled environment to assess reasoning, code generation, and execution robustness608

across diverse spreadsheet tasks.609

Granularity Instructions Test Cases
Cell-Level 329 986
Sheet-Level 583 1,743

Total 912 2,729
Table 4: Cell-level vs. sheet-level distribution in SpreadsheetBench.

A.5 KB Construction and Retrieval Details610

Training Data Collection611

• OSWorld: 20 successful trajectories (2 per application domain) and 10 for evals.612

• τ2-Bench: 20 trajectories balanced across domains and difficulty settings and 10 for evals.613

• SpreadsheetBench: Uniformly sample 30 trajectories for training and 10 for evaluation.614

All numbers are reported on the remaining train set.615

Retrieval Strategy616

• Query Formation: For each task we take in the seed Natural Language query as the retrieval617

query.618

• Retrieval Count: We take top-3 documents for all the retrieval steps619

• Integration Point: For SPREADSHEET ENCH and OSWorld we insert retrievals in the620

system prompt augmentation. For τ2-bench we add perfrom retrieval after each user621

interaction.622

B Qualitative Analysis623

Exploration on MCTS parameters WE evaluate OSworld on two different MCTS parameters.624

• Increased Depth: To increase the depth we keep maximum width of the tree as 3 and depth as625

10 with max number of iterations as 25. We observe that the Knowledge base over optimizes626

on the train set leading to a poorer performance on test set.627

• Increased Width: For increased width we reverse the parameters where depth is 3 and628

maximum width is 10 with max iterations 25. We observe many different styles of KBs are629

generated storing very similar information, these different styles lead to a varied performance630

on both eval and test set notifying the importance of state search.631

We report the numbers on table ??632

Baseline max_width=3, max_depth=3 max_width=3, max_depth=10 max_width=10, max_depth=3
OSworld 44.20 47.56 43.83 49.32

Table 5: OSworld difference in MCTS parameters
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C Exemplar Knowledge Bases633

C.1 Knowledge base learned for OSWorld634

We showcase a small part of knowledge base learned thought BREW . This demonstrate 3 major635

parts on which each document is aggregated. These parts discuss when to use a piece of information,636

why to use the information, how to use the information/tool.637

638
## Search and Open Files639

640

**When to use**: Locating documents, spreadsheets, images, or downloads for641

editing, conversion, or attachment.642

643

### How to Perform644

- Open **File Manager (Nautilus)** from launcher or system dock645

- Press ‘Ctrl + F‘ or click the search icon646

- Enter part of filename, full name, or wildcard (‘*.pdf‘, ‘report*‘)647

- Use right-click →**Open With** to choose the desired application648

- Use the sidebar to navigate to **Downloads**, **Documents**, or custom folders649

650

### Additional Actions651

- Right-click →**Properties** to check modification date or file type652

- Sort results by Date, Type, or Name from the top-right dropdown653

- Use ‘F2‘ to rename files inline654

655

### Example656

- Task: "Edit the file titled ‘sales_report_march.ods‘"657

- Search for ‘sales‘ in File Manager658

- Confirm ‘.ods‘ type and open with LibreOffice Calc659

660

...661

662

## Insert Images663

664

**When to use**: Adding visual elements to documents, presentations, emails, or665

templates.666

667

### How to Perform668

- Navigate to **Insert →Image →From File** (in Writer, Impress, Thunderbird)669

- Select an image file (‘.png‘, ‘.jpg‘, ‘.svg‘) from the file dialog670

- Use drag handles to resize; right-click →**Wrap** or **Alignment** for layout671

672

### Additional Actions673

- In GIMP: **File →Open as Layers** to insert image as a new layer674

- Use drag-and-drop from file manager into open document windows675

- Use **Format →Image** to apply borders, shadows, or color corrections (in676

Writer/Impress)677

678

### Example679

- Task: "Insert the logo.png image into the title slide"680

- Open ‘.odp‘ file in Impress →Go to Slide 1 →Insert →Image →Select ‘logo.681

png‘682

683

...684

685

## Export as PDF686

687

**When to use**: Required submission format688

689

### How to Perform690

- Go to **File →Export As PDF**691

- Choose output folder (usually **Documents** or **Downloads**)692

- Click **Save**, then confirm the exported file opens correctly693

694
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### Additional Actions695

- In GIMP or Impress: choose **File →Export As**, then select ‘.pdf‘ from696

format list697

- Use **Save As** to preserve both editable and exported versions separately698

699

### Example700

- Task: "Export the flyer.xcf as a PDF"701

- Open in GIMP →File →Export As →Rename to ‘flyer.pdf‘ →Click Export702703

C.2 BREW Knowledge Base for τ2-Bench704

BREW enable use to learn relevant information for tau bench for across the domains in a single705

knowledge base. This knowledge base is helpful to use relevant actions from the action pool.706

707
708

### Additional Actions709

710

* Inform the user:711

- Refunds via gift card = immediate.712

- Refunds via other methods = –57 business days.713

714

### Example715

716

* Task: "Cancel a T-shirt order placed yesterday"717

* Validate: Status is ‘pending‘718

* Reason: "no longer needed"719

* Confirm720

* Execute tool call721

722

723

# Exchange Delivered Order724

725

**When to use**:726

User wants to swap delivered items for a different variant (e.g., size or color)727

.728

729

**Why to use it**:730

To fix sizing or option errors without needing a new purchase.731

732

### How to Perform733

- Authenticate user734

- Confirm order status is ‘delivered‘735

- Get full list of exchange items736

> "Please ensure all items for exchange are listed. This step ’cant be repeated.737

"738

- Ask for refund/payment method739

- Confirm:740

> "’Youre exchanging item X for same product, different option. Proceed?"741

- On confirmation:742

‘‘‘python743

request_exchange(order_id="45678", item_exchanges=[...], payment_method="744

paypal")745

‘‘‘746

747

### Additional Actions748

749

* Mention: An email will be sent with return instructions750

* Validate that the new variant is from the same product751

752

### Example753

754

* Task: "Exchange red shirt for blue in Order #45678"755

* Confirm all exchange items756

* Confirm payment method for difference757
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* Execute tool call758

759

### Example760

761

* Task: "Show me my last 2 orders"762

* Authenticate763

* Retrieve and present info764

765

# Deny Unsupported Request766

767

**When to use**:768

User asks for an unsupported action (e.g., cancel processed order, exchange to769

different product type, help another user).770

771

**Why to use it**:772

To stay compliant with platform policy.773

774

### How to Perform775

- Politely reject:776

> "’Im sorry, but I ’cant process that request. ’Its outside the allowed scope.777

"778

779

### Example780

781

* Task: "Cancel a processed order"782

* Respond with denial message783

# Transfer to Human Agent784

785

**When to use**:786

User needs help outside the ’assistants permitted capabilities.787

788

**Why to use it**:789

To ensure user gets the right help from trained staff.790

791

### How to Perform792

- Make tool call:793

‘‘‘python794

transfer_to_human_agents()795

‘‘‘796

- Then inform user:797

> "YOU ARE BEING TRANSFERRED TO A HUMAN AGENT. PLEASE HOLD ON."798

799

### Example800

801

* Task: "Delete a task"802

* Deny deletion803

* Transfer to human804805

C.3 BREW Knowledge Base for SpreadsheetBench806

807
Header Extraction808

1. Detecting Header Rows809

Overview:810

To accurately identify header rows, scan the initial region of your dataset.811

This process is crucial for mapping column information for further812

processing.813

814

Approaches:815

- Heuristic Checks:816

- Look for rows where all cells are strings (e.g., "Name", "Date", "Region", "817

Amount").818

- Identify rows with distinctive formatting such as bold text or background819

color.820

- Example:821
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| Name | Date | Region | Amount | |-------|-----------|-----------|--------| |822

John | 2024-01-01| North | 100 |823

- Pattern Recognition:824

- Use regex to match typical header patterns, such as column names starting with825

uppercase letters.826

- Score candidate rows based on the likelihood of being headers.827

- Multi-Table Sheets:828

- Detect gaps, empty rows, or separators indicating a new table.829

- Assign a Table ID to each detected table for later reference.830

831

Edge Cases:832

- Merge multi-row headers (e.g., "Sales" over "2024", "2025" becomes "Sales 2024833

", "Sales 2025").834

- Fill in missing headers by inferring from context.835

836

2. Assigning and Validating Headers837

Overview:838

Once headers are detected, assign them programmatically and ensure they match839

expected schema and data types.840

841

Implementation:842

- Column Naming:843

- Set names in code, e.g., df.columns = ["Name", "Date", "Region", "Amount"].844

- Schema Mapping:845

- Map headers to a standardized schema, using external files or user prompts.846

- Example:847

- Raw header: "Amt"; Mapped header: "Amount"848

- Quality Checks:849

- Detect duplicate or empty headers ("Date", "Date" becomes "Date_1", "Date_2").850

- Validate each column’s expected data type.851

852

3. Automation and Usability Enhancements853

Overview:854

Enhance usability and automation to streamline header extraction and user855

interaction.856

857

Features:858

- Freeze Panes:859

- Automatically freeze header rows in Excel for easier navigation.860

- Highlighting:861

- Use colored formatting to visually distinguish headers.862

- Example:863

- Yellow fill for header row.864

- Documentation:865

- Log extraction logic and confidence scores for each detected header.866

- Integration:867

- Build header extraction into ETL pipelines and record process metadata.868

869

Block Detection870

1. Identifying Block Boundaries871

Overview:872

Block detection segments data into logical units or tables.873

874

Methods:875

- Boundary Detection:876

- Find empty rows, repeated labels, or formatting changes.877

- Example:878

| Name | Amount | |------|--------| | John | 100 | | | | <-- Empty row indicates879

new block | Name | Amount | | Alice| 200 |880

- Machine Learning:881

- Train classifiers to detect block boundaries based on cell patterns.882

883

Advanced:884

- Detect nested blocks or hierarchies using indentation or merged cells.885

- Identify summary blocks with keywords like "Total" or "Summary".886
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887

2. Processing and Tracking Blocks888

Overview:889

Once blocks are detected, assign IDs and enable block-level analysis.890

891

Actions:892

- Block ID:893

- Assign unique IDs (e.g., Block_001, Block_002).894

- Analysis:895

- Perform group-by or aggregation within each block.896

- Example:897

- Sum "Amount" for Block_001: 100 + 150 = 250898

899

3. Additional Block Actions900

Overview:901

Enable modular analysis and reporting at the block level.902

903

Features:904

- Summary Rows:905

- Add computed totals/averages for each block.906

- Export/Save:907

- Save blocks as separate files or sheets.908

- Example:909

- Export Block_001 to "block1.csv"910

911

Search for Values or Patterns912

1. Search Execution Methods913

Overview:914

Efficiently locate specific values or patterns in your data.915

916

Techniques:917

- Manual Tools:918

- Use Ctrl + F in Excel for quick lookups.919

- Programmatic Search:920

- Scan all cells using loops or vectorized code.921

- Example:922

- Find all instances of "North" in the "Region" column.923

- Pattern Matching:924

- Support exact, wildcard (*Total*), and regex (\d{4}-\d{2}-\d{2} for dates).925

926

2. Recording and Highlighting Results927

Overview:928

Log and visualize search matches for user review.929

930

Actions:931

- Logging:932

- Record coordinates (e.g., Sheet1, Row 3, Col "Region").933

- Highlighting:934

- Apply conditional formatting to search hits.935

936

3. Advanced Search Scenarios937

Overview:938

Handle complex or large-scale search requirements.939

940

Scenarios:941

- Merged Cells:942

- Search within merged cells or across multiple sheets.943

- Export:944

- Export found results for further analysis.945

- Example:946

- Export all rows containing "John" to "john_results.csv"947

948

Writeback Results949

1. Output Placement950

Overview:951
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Choose where and how to insert results.952

953

Options:954

- Target Columns:955

- Select existing or blank columns for output.956

- Appending:957

- Add new columns for flags, counts, or statuses.958

- Example:959

- Add "Approved_Flag" column next to "Status".960

961

2. Writing and Styling Results962

Overview:963

Automate and style the output for visibility.964

965

Methods:966

- Formulas/Code:967

- Use code (e.g., ws.cell(row, col).value = result) to insert results.968

- Styling:969

- Bold, borders, or colors for output cells.970

- Example:971

- Green fill for "Success", red for "Error".972

973

3. Audit and Protection974

Overview:975

Maintain the integrity and traceability of results.976

977

Measures:978

- Lock Columns:979

- Prevent edits to output columns.980

- Timestamps/User Info:981

- Add audit trail for writebacks.982

- Example:983

- "2024-06-01, User: admin"984

985

Difference in State986

1. Sheet Comparison987

Overview:988

Identify changes between input and output sheets.989

990

Process:991

- Load Sheets:992

- Read both sheets into memory.993

- Compare Cells:994

- Detect differences by position and value.995

996

2. Recording and Reporting Differences997

Overview:998

Log and report all detected changes.999

1000

Actions:1001

- Log Mismatches:1002

- Record cell coordinates and values.1003

- Example:1004

- Cell B3: "North" →"South"1005

- Export Diff Report:1006

- List all detected differences for review.1007

1008

3. Visualization and Automation1009

Overview:1010

Make changes visible and automate validation.1011

1012

Features:1013

- Highlight Changes:1014

- Color code changed cells.1015

- Automate Checks:1016
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- Integrate diff comparisons into test scripts.1017

1018

Column Selection1019

1. Selection Criteria1020

Overview:1021

Choose relevant columns for analysis.1022

1023

Methods:1024

- Labels/Indices:1025

- Select by name or position.1026

- Dynamic Rules:1027

- E.g., all numeric columns.1028

- Assign Roles:1029

- Example: "ID", "Date", "Metric"1030

1031

2. Preparation and Validation1032

Overview:1033

Prepare columns for consistent use.1034

1035

Actions:1036

- Rename/Relabel:1037

- Standardize column names.1038

- Validate Types:1039

- Ensure columns are of expected type.1040

- Example:1041

- "Date" column as datetime.1042

1043

3. Reusability1044

Overview:1045

Save and reuse column selections.1046

1047

Features:1048

- Presets:1049

- Save selection profiles.1050

- Downstream Use:1051

- Use validated columns in subsequent processes.1052

1053

Filter Rows1054

1. Filtering Methods1055

Overview:1056

Refine your dataset with filters.1057

1058

Techniques:1059

- Spreadsheet Tools:1060

- Use built-in filters.1061

- Code Logic:1062

- Filter with code (e.g., df[df[’Status’] == ’Approved’]).1063

- Multiple Criteria:1064

- Combine conditions (AND/OR).1065

- Example:1066

- Status = "Approved" AND Amount > 1001067

1068

2. Helper Columns and Complex Filters1069

Overview:1070

Simplify filtering using helper columns.1071

1072

Actions:1073

- Helper Columns:1074

- Compute intermediate flags.1075

- Document Logic:1076

- Record filtering rules for audit.1077

1078

3. Post-Filter Actions1079

Overview:1080

Visualize and export filtered data.1081
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1082

Features:1083

- Highlighting:1084

- Grey-out filtered-out rows.1085

- Export:1086

- Save the filtered dataset.1087

1088

Merge Tables1089

1. Key-Based Merging1090

Overview:1091

Combine tables using shared keys.1092

1093

Techniques:1094

- Join Operations:1095

- Use VLOOKUP, JOIN, or code merges.1096

- Example:1097

- Merge "Customer_ID" from two tables.1098

- Align Data:1099

- Match on columns like "ID", "Name".1100

1101

2. Stack-Based Merging1102

Overview:1103

Append tables when keys ’arent needed.1104

1105

Methods:1106

- Vertical Append:1107

- Combine rows from similar tables.1108

- Deduplicate:1109

- Remove duplicate records.1110

1111

3. Tracking and Audit1112

Overview:1113

Track source and unmatched records.1114

1115

Actions:1116

- Source Column:1117

- Add "Source" to indicate origin.1118

- Highlight Unmatched:1119

- Mark or export mismatched rows.1120

1121

Pivot or Unpivot1122

1. Pivoting Data1123

Overview:1124

Summarize data using pivots.1125

1126

Methods:1127

- PivotTables:1128

- Group by row/column dimensions.1129

- Example:1130

- Sum "Amount" by "Region".1131

- Aggregation:1132

- Choose SUM, AVG, COUNT, etc.1133

1134

2. Unpivoting (Melting) Data1135

Overview:1136

Reshape data from wide to long format.1137

1138

Techniques:1139

- Melt Operations:1140

- Convert columns into rows.1141

- Example:1142

-1143

| Year | Sales_2019 | Sales_2020 | |------|------------|------------|1144

→1145

| Year | Sales_Year | Value |1146
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- Flexible Restructuring:1147

- Selectively unpivot non-ID columns.1148

1149

3. Post-Pivot Actions1150

Overview:1151

Prepare pivoted data for export.1152

1153

Features:1154

- Flatten Pivot Table:1155

- Convert back to flat for further analysis.1156

- Reorder/Rename:1157

- Clarify pivoted fields.1158

1159

Map with Lookup Tables1160

1. Mapping Techniques1161

Overview:1162

Standardize data using lookups.1163

1164

Methods:1165

- Functions:1166

- Use VLOOKUP, merge with dictionaries.1167

- Code-to-Label:1168

- Example:1169

- Code "N" →Label "North"1170

1171

2. Application and Fallbacks1172

Overview:1173

Apply lookups and handle missing values.1174

1175

Actions:1176

- Apply Mappings:1177

- Across selected columns.1178

- Handle Missings:1179

- Use defaults for missing codes.1180

1181

3. Audit and Display1182

Overview:1183

Ensure mapping transparency.1184

1185

Features:1186

- Cache Mappings:1187

- Store for repeated use.1188

- Display Codes/Labels:1189

- Show both for clarity.1190

1191

Fill Missing Data1192

1. Choosing Fill Methods1193

Overview:1194

Impute missing data appropriately.1195

1196

Techniques:1197

- Forward/Backward Fill:1198

- Fill gaps with prior/next value.1199

- Default Values:1200

- Use fixed placeholder (e.g., 0, "Unknown").1201

- Contextual Example:1202

- Dates: Fill missing month with last known month.1203

1204

2. Application and Auditing1205

Overview:1206

Apply fills and flag for review.1207

1208

Actions:1209

- Targeted Filling:1210

- Apply to specific columns/rows.1211
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- Flag Filled Cells:1212

- Highlight for later review.1213

1214

3. Documentation1215

Overview:1216

Keep fill logic transparent.1217

1218

Features:1219

- Record Logic:1220

- Document assumptions and methods.1221

- Audit Trail:1222

- Track all changes.1223

1224

Flag Rows or Cells1225

1. Defining Flag Rules1226

Overview:1227

Establish criteria for flagging.1228

1229

Examples:1230

- Simple Rule:1231

- Flag where Amount < 01232

- Complex Rule:1233

- Flag where Status = "Pending" and Amount > 10001234

1235

2. Applying Flags1236

Overview:1237

Insert flags and summarize.1238

1239

Actions:1240

- Flag Column:1241

- Add "Flag" column with "Yes"/"No".1242

- Export Flagged Rows:1243

- Save for further inspection.1244

1245

3. Advanced Flagging1246

Overview:1247

Use multiple criteria and document.1248

1249

Features:1250

- Multi-Criteria:1251

- Combine several rules for granular checks.1252

- Notes:1253

- Document flagging rationale.1254

1255

Sort Data1256

1. Setting Sort Criteria1257

Overview:1258

Organize data for analysis.1259

1260

Options:1261

- Sort Columns:1262

- By value, ascending/descending.1263

- Multi-Level:1264

- E.g., sort by "Region", then by "Amount".1265

1266

2. Applying Sorts1267

Overview:1268

Implement sorting programmatically or manually.1269

1270

Methods:1271

- Spreadsheet Tools:1272

- Built-in sort features.1273

- Code:1274

- E.g., df.sort_values([’Region’, ’Amount’])1275

1276
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3. Post-Sort Actions1277

Overview:1278

Finalize sorted data.1279

1280

Actions:1281

- Renumber Rows:1282

- Update indices.1283

- Highlight Extremes:1284

- Mark top/bottom values.1285

1286

Validate Data1287

1. Validation Checks1288

Overview:1289

Ensure data meets required standards.1290

1291

Checks:1292

- Type:1293

- Ensure numeric columns contain numbers.1294

- Range:1295

- E.g., "Amount" > 0.1296

- Pattern:1297

- Date columns match YYYY-MM-DD.1298

- Business Rule Example:1299

- "Start Date" < "End Date"1300

1301

2. Marking and Reporting1302

Overview:1303

Visualize and report errors.1304

1305

Actions:1306

- Highlight Invalids:1307

- Color-code errors.1308

- Export Summary:1309

- Table of error counts and locations.1310

1311

3. Integration in Workflow1312

Overview:1313

Make validation a routine part of processing.1314

1315

Features:1316

- Pre-Processing Step:1317

- Validate before analysis.1318

- Automation:1319

- Integrate into data pipelines.1320

1321

Split Sheets or Data1322

1. Defining Split Rules1323

Overview:1324

Segment data for modular analysis.1325

1326

Methods:1327

- By Category:1328

- E.g., split by "Region".1329

- By Date Range:1330

- E.g., split by year.1331

1332

2. Exporting Segments1333

Overview:1334

Save segments for separate use.1335

1336

Actions:1337

- Export Files:1338

- "North_Region.csv", "South_Region.csv"1339

- Consistent Formatting:1340

- Ensure identical columns and styling.1341
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1342

3. Automation and Documentation1343

Overview:1344

Automate splitting and track provenance.1345

1346

Features:1347

- Automation:1348

- Use scripts/macros for repeated splits.1349

- Documentation:1350

- Record rules and export logs.13511352

D Qualitative Analysis of BREW-Generated Knowledge Bases1353

This section presents a comprehensive qualitative analysis of knowledge bases generated through1354

the BREW technique applied to two distinct agent training environments: OSWorld and τ2Bench1355

described in the section before. The analysis examines knowledge representation patterns, procedural1356

sophistication, and domain-specific learning characteristics extracted from CUA agent behaviors,1357

providing insights into the effectiveness and scope of knowledge distillation techniques across diverse1358

task environments.1359

D.1 Cross-Domain Knowledge Base Analysis1360

D.1.1 Base Structure & Organization1361

Schema Consistency and Evolution: Both knowledge bases demonstrate consistent structural1362

schemas, though adapted to their respective domains. The OSWorld KB employs a four-part1363

schema (contextual triggers, procedural steps, extended capabilities, concrete instantiation), while the1364

τ2Bench KB extends this to a five-part structure, adding explicit purpose rationale (“Why to use it”).1365

This evolution suggests that BREW adapts its extraction patterns to domain-specific requirements—1366

conversational commerce demands explicit justification for actions due to customer interaction1367

contexts.1368

Taxonomic Organization Principles: The OSWorld KB reveals a capability-based taxonomy1369

organized around computational tasks: file operations, document processing, inter-application work-1370

flows, and data visualization. Each category represents a distinct computational domain with specific1371

tool requirements and interaction patterns. In contrast, the τ2Bench KB employs a lifecycle-based1372

taxonomy structured around transactional states: order creation, modification, fulfillment, and1373

post-delivery operations. This organizational difference reflects fundamental domain characteristics—1374

desktop automation focuses on tool orchestration, while conversational commerce centers on process1375

management.1376

Hierarchical Task Decomposition: Both KBs demonstrate sophisticated hierarchical reasoning, but1377

through different decomposition strategies. OSWorld exhibits technical decomposition, breaking1378

complex operations like “Create Charts from Data” into constituent technical steps (data selection,1379

chart insertion, customization, formatting). τ2Bench shows process decomposition, structuring1380

operations like order modification into authentication, validation, confirmation, and execution phases.1381

This suggests BREW successfully identifies domain-appropriate decomposition strategies rather than1382

applying uniform patterns.1383

Knowledge Boundary Definition: Both KBs explicitly encode operational boundaries, but through1384

contrasting mechanisms. OSWorld boundaries are capability-constrained—determined by available1385

applications and system resources. τ2Bench boundaries are policy-constrained—explicitly defined1386

through “Deny Unsupported Request” patterns and escalation protocols. This difference highlights1387

how knowledge extraction adapts to domain-specific constraint types.1388

D.1.2 Procedural Knowledge Grounding1389

Context-Dependent Action Selection: Both domains demonstrate sophisticated context awareness,1390

but grounded in different environmental factors. OSWorld exhibits application-context sensitivity,1391

where identical operations (e.g., image insertion) require different procedures across LibreOffice1392

Writer, Impress, GIMP, and Thunderbird. The agent learned application-specific affordances and1393

30



interaction patterns rather than generic command sequences. τ2Bench demonstrates state-context1394

sensitivity, where available actions depend on order status (pending vs. delivered), payment methods,1395

and authentication levels. This reveals learned understanding of business process constraints and1396

temporal operation windows.1397

Error Prevention and Validation Workflows: Both KBs incorporate sophisticated error prevention1398

mechanisms, but grounded in domain-specific failure modes. OSWorld emphasizes technical valida-1399

tion: file integrity checks (“confirm the exported file opens correctly”), application state verification,1400

and multi-step confirmation for irreversible operations. τ2Bench emphasizes transactional valida-1401

tion: authentication cascades, confirmation dialogues with standardized templates, and explicit user1402

consent protocols. The emergence of defensive programming practices across both domains suggests1403

these represent fundamental principles of reliable agent behavior.1404

State-Dependent Decision Logic: The procedural knowledge in both domains demonstrates sophisti-1405

cated state machine reasoning. OSWorld exhibits application state awareness—understanding when1406

applications are ready for input, when files are loaded, and when operations can be safely executed.1407

Window management and application switching reveal learned understanding of desktop metaphors1408

and resource constraints. τ2Bench demonstrates business process state awareness—finite state1409

machine reasoning where order lifecycle states determine available operations. The agent learned1410

that pending orders enable modification while delivered orders unlock return workflows, indicating1411

internalized understanding of business logic constraints.1412

Security and Authentication Grounding: While OSWorld operates in a trusted desktop environment1413

with minimal explicit security concerns, τ2Bench reveals pervasive authentication-first paradigms.1414

Nearly every transactional operation begins with identity verification through email, name, and zip1415

code combinations. The KB demonstrates graduated security reasoning: information retrieval1416

requires basic authentication while financial transactions trigger rigorous verification protocols. This1417

contrast highlights how procedural knowledge adapts to domain-specific security requirements.1418

Cross-Application vs. Cross-Process Orchestration: OSWorld demonstrates technical orches-1419

tration—coordinating multiple applications (Chrome, LibreOffice suite, File Manager, GIMP) to1420

accomplish complex workflows. The “Navigate Between Applications” section reveals learned be-1421

haviors for window management, application switching, and resource coordination. τ2Bench exhibits1422

process orchestration—coordinating authentication, validation, confirmation, and execution phases1423

across different operational contexts. Both forms of orchestration require sophisticated temporal1424

reasoning and constraint management, but applied to different environmental complexity types.1425

Failure Mode Internalization: Both KBs reveal learned understanding of domain-specific failure1426

modes. OSWorld incorporates file validation, application crash recovery suggestions, and verification1427

steps for critical operations. τ2Bench includes explicit escalation protocols (“Transfer to Human1428

Agent”), policy compliance mechanisms, and irreversibility warnings for financial operations. The1429

consistent emergence of failure-aware procedures suggests that agents successfully internalize risk1430

assessment and mitigation strategies during training.1431

Domain-Specific Communication Patterns: The procedural knowledge reveals distinct communica-1432

tion paradigms appropriate to each domain. OSWorld procedures are task-oriented with minimal1433

user interaction—focusing on efficient command execution and verification. τ2Bench procedures are1434

dialogue-oriented with standardized customer interaction templates, confirmation protocols, and1435

expectation management communications. This adaptation demonstrates that BREW extracts not just1436

procedural logic but domain-appropriate interaction modalities.1437

The cross-domain analysis reveals that BREW successfully extracts procedural knowledge that is both1438

structurally consistent (following learnable organizational patterns) and contextually grounded1439

(adapted to domain-specific constraints, failure modes, and interaction requirements). This dual capa-1440

bility suggests significant potential for knowledge transfer across related domains while maintaining1441

appropriate domain-specific adaptations.1442
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